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IMPORTANT SAFETY WARNINGS
Federal Communication Commission Interference Statement

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the 
FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential 
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee 
that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct 
the interference by one of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device 
may not cause harmful interference, and (2) this device must accept any interference received, including interference that 
may cause undesired operation.

FCC Caution: Any changes or modifications not expressly approved by the party responsible for compliance could void the 
user’s authority to operate this equipment.

IMPORTANT NOTE:

FCC Radiation Exposure Statement:

This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment. End users must 
follow the specific operating instructions for satisfying RF exposure compliance.

This transmitter must not be co-located or operating in conjunction with any other aerial or transmitter.

In order to maintain compliance with FCC regulations, shielded cables must be used with this equipment. Operation with 
non-approved equipment or unshielded cables is likely to result in interference to radio and TV reception. The user is 
cautioned that changes and modifications made to the equipment without the approval of manufacturer could void the user’s 
authority to operate this equipment.

The Magellan Triton must be installed and operated at a distance no closer then 8 inches (20 cm) from the user.

This Class B digital device meets all requirements of the Canadian Interference-Causing Equipment Regulations.
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IMPORTANT SAFETY WARNINGS
IC statement

Operation is subject to the following two conditions:

1. This device may not cause interference.
2. This device must accept any interference, including interference that may cause undesired operation of the 

device.

IMPORTANT NOTE:

IC Radiation Exposure Statement:

This equipment complies with IC radiation exposure limits set forth for an uncontrolled environment. End users must follow 
the specific operating instructions for satisfying RF exposure compliance. 

This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

The information provided in this document is subject to change without notice. Improvements and enhancements to the 
product may occur without any formal notification. Check the Magellan website (www.magellanGPS.com) for product 
updates and additional information.

Underwriters Laboratories Inc. (“UL”) has not tested the performance or reliability of the Global Positioning System (“GPS”) 
hardware, operating software or other aspects of this product. UL has only tested for fire, shock or casualties as outlined in 
UL’s Standard(s) for Safety for Information Technology Equipment, UL60950-1. UL Certification does not cover the 
performance or reliability of the GPS hardware and GPS operating software. UL MAKES NO REPRESENTATIONS, 
WARRANTIES OR CERTIFICATIONS WHATSOEVER REGARDING THE PERFORMANCE OR RELIABILITY OF ANY GPS 
RELATED FUNCTIONS OF THIS PRODUCT. 

Maximum normal use temperature is 66°C.

 

© 2008 Magellan Navigation, Inc. All rights reserved. The Magellan Logo, Magellan, and Magellan Triton are trademarks of 
Magellan Navigation, Inc. No part of this user manual may be reproduced or transmitted in any form or by any means, 
electronic or mechanical, including photocopying and recording, for any purpose other than the purchaser’s personal use, 
without the prior written permission of Magellan Navigation, Inc.

604-0007-001 A
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Overview

Thank you for your purchase of the Magellan Triton GPS receiver.  The Magellan Triton was designed 
for the outdoor enthusiast with all the features needed to make your outdoor adventures safe and 
enjoyable.

Be sure to register your Magellan Triton at www.magellangps.com to be kept informed of possible 
software updates and new features as they become available.  Also visit the Magellan Triton support 
page at www.magellangps.com/support/ and select your Magellan Triton model for additional 
information and tips on the use of your Triton.

Features of the Magellan Triton 2000

2.7” color touch screen – The brilliant colors and touchscreen controls provide an easy-to-read 
display that makes selecting functions as easy as touching the screen.

Ease-of-use – Simple menus and an intuitive interface makes using the Magellan Triton easy for 
first time GPS receiver users while still keeping all the functions experienced users expect to see.

Routes and tracks – Create a single leg Go To route, a route with multiple destinations or just use 
the backtrack function to follow your footsteps back to your point of origin.  

3-meter accuracy – The SiRFstarIII™ GPS chipset and an integrated multidirectional antenna 
offer superior GPS accuracy.  The Magellan Triton is also WAAS and EGNOS-capable, taking 
advantage of the Wide Area Augmentation System for improved accuracy.

3-axis electronic compass – Get accurate compass readings while standing still, even without a 
GPS fix, and no matter how you hold the receiver. (GPS receivers without an electronic compass 
require that you are moving before the compass shows your correct heading.)

Barometer – Sensitive barometric pressure readings offer advanced notice of changing weather 
conditions.

Built-in map – A built-in base map of the continental United States and Canada display major 
highways, city centers, bodies of water and much more.

Ability to add detailed maps – Access optional detail maps for marine cartography, topographic 
maps, as well as feature-packed National Geographic maps from an SD card that can be installed 
in the Magellan Triton.

SD-card expansion - Use an optional SD memory card to upload detailed maps and store media.

2 mega-pixel camera - Take clear beautiful pictures or videos of your adventure as you navigate 
and attach them to waypoints so you can easily find your way back to the same spot or to share 
with family and friends.

Flashlight - Light your way with a powerful LED flashlight. Low power consumption helps 
maximize battery life.

Voice recorder - Microphone and speaker enable you to record audio notes and attach them to 
waypoints, share with friends and family or easily find your way back next time.

Digital music player - Upload your digital music to an optional SD card and enjoy a customized 
soundtrack as you explore. Plug in any standard headphones (optional accessory) for clear private 
listening.

External antenna connector - Simply plug in an external antenna (optional accessory) in your boat 
or off-road vehicle for enhanced GPS signal reception.

Audio jack - Plug in any standard 1/8" headphones (optional accessory) to enjoy clear private 
listening of your digital music, voice notes and other recordings.
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A Backlight and Flashlight Button
B Hold Switch (under protective rubber cover)
C External Antenna Connector (under protective rubber cover)
D Data Connector and Camera (Back)
E Stylus
F Zoom - (Zoom out) Button
G Page / Go To Button
H Esc (Escape) Button
I Zoom + (Zoom in) Button
J Menu Button
K Enter Button / Cursor Control
L Microphone
M Power Button
N SD Card Slot (under protective rubber cover)
O Headphone Jack (under protective rubber cover)
P Reset
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Specifications

PHYSICAL

PERFORMANCE

POWER

Case Rubber armored impact-resistant plastic, water-resistant seal, IPX-7
Base Map Built-in base map of the continental United States and Canada.
Size 5.75" x 2.5" x 1.13"  (14.6 x 6.35 x 2.87 cm)
Weight 8.0 oz (227 g) - w/ battery
Display 2.7" (6.86 cm) diagonal, QVGA (240X320) resolution and touch screen 

(LED backlit)
Data Storage Secure Digital (SD) Card (optional accessory)
Antenna Built-in multidirectional patch (or optional external antenna)
Keypad Nine direct-access keys
Operating Range 14° to 140°F (-10° to 60°C)

Receiver SiRF Star III™ 20 channels, WAAS/EGNOS
Acquisition Time Hot: 20 seconds, Cold: 60 seconds, Initial: 2 minutes
Update Rate Once per second
Accuracy 3 to 5 meters (10 - 16 feet) - WAAS/EGNOS, < 7 meters (15 feet) - GPS 

only
Languages English, French, German, Dutch, Danish, Swedish, Spanish, Italian, 

Portuguese, Finnish, Norwegian
Coordinate Systems Latitude/Longitude, UTM, OSGB, Irish, Swish, Swedish, Finnish, German, 

French, USNG, MGRS, Indian, Nederlands

Source Two AA Batteries (included)
Battery Life Up to 10 hours
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Fundamentals

Turning the Triton on

1. Press and hold the power button until the Triton 
splash screen is displayed.

Turning the Triton off
When turning off the Triton you can select to have it 
shutdown or go into suspend mode.

1. Press the Power button and the Triton will begin the 
shutdown sequence.

2. To place the Triton in suspend mode, press Enter 
before the shutdown sequence is complete.

3. To cancel the shutdown sequence and return to the last viewed screen, press any key or tap 
the screen.

4. If after 5 seconds no key has been pressed, the Triton will shutdown.

Setting the display backlight intensity
Depending upon the lighting conditions you are in you may need to change the backlight settings for 
the display.  There are five levels of backlight intensity, press the backlight button momentarily to 
step through each level of backlight intensity.

1. Press the backlight button momentarily.  The 
backlight intensity will increase 20% until it reaches 
the maximum intensity.  Pressing the backlight 
button again will turn off the display backlight.

Please note that reducing the backlight setting will increase 
the battery life for the Triton.  Refer to the section in this 
chapter on Battery Life for other tips on extending the 
Triton’s battery life.  Also note that the backlight and the 
flashlight use the same button on the Magellan Triton.  Press 
the button momentarily to control the backlight setting, press 
and hold the button to turn the flashlight on and off. 

Setting the Time Zone
The time and date information will be computed from information from the GPS satellites so there is 
no requirement for you to input any time or date information.  However, to make the time accurate 
for your location you must select the correct time zone.

1. From the Map screen press MENU.

2. Select View.

3. Select Profiles.

4. Select the profile you want to use.  (See the chapter on Profiles for more information.)

5. Press the PAGE / GO TO button to change the page to the Display page.

Press button 
momentarily
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6. Scroll down the page and select the Time Zone field.

7. From the drop-down menu, select your current time zone.  (Time zones are not changed 
automatically when travelling.  If you travel to an area with a different time zone, you will 
need to change it here for accurate time information.)

8. Repeat the process for the Daylight Savings field.

9. Press the PAGE / GO TO button until the Info page is displayed.

10. Select Activate Profile.

Changing Languages

1. From the Map screen press MENU.

2. Select View.

3. Select Profiles.

4. Select the profile you want to use.  (See the chapter on Profiles for more information.)

5. Press the PAGE / GO TO button to change the page to the Display page.

6. Scroll down the page and select the Language field.

7. From the drop-down menu, select the desired language.

8. Press the PAGE / GO TO button until the Info page is displayed.

9. Select Activate Profile.

Sleep Mode (Backlight Timer)

To conserve battery life the Triton will go into Sleep Mode at a preset interval when no keys have been 
pressed.  

Waking up the Triton from Sleep Mode

1. Press any key and the Triton will wake up, turning the backlight on to the previous setting.

Setting the Backlight Timer

1. From the Map screen, press MENU.

2. Select View.

3. Select Profiles.

4. Select the profile desired.

5. Select the Display Options icon at the top of the 
display. Select Backlight Timer.

6. Choose the interval that the backlight will turn off 
with no keys pressed.  You can also select Off if you want the backlight to remain on as long 
as the Triton is turned on.

Display Options Icon
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Automatic Power Off

The Triton can be set to automatically go into suspend mode when no keys have been pressed.  This 
saves battery life if you forget to turn off the Triton.

Setting the Power Off Timer interval.

1. From the Map screen, press MENU.

2. Select View.

3. Select Profiles.

4. Select the profile desired.

5. Select the Display Options icon at the top of the display.

6. Select Power Off Timer.

7. Choose the interval that the Triton will turn off with no keys pressed. You can also select Off 
if you want the Triton to not turn off automatically.

Hold Switch

Sometimes you may find that you want the Triton to keep computing your position but you are keeping 
it in your backpack or some other area where the keys might be pressed accidently.  To prevent 
accidental key presses, the Triton has a Hold Switch that disables the keys and the touchscreen but 
the Magellan Triton will continue to compute position information.

Setting the Hold Switch

1. Lift the protective cover from the Hold Switch.

2. Slide the Hold Switch down to turn off the keys and touchscreen, 
up for normal operation.
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Flashlight

The Triton has a three LED flashlight located at the top of the receiver.  This can be used in 
emergency situations when you need quick access to a flashlight.  To conserve battery life it is 
recommended that you use the flashlight only when needed.

Turning the flashlight on or off.

1. Press and hold the Flashlight button for at least 4 
seconds to turn the flashlight on.

2. Press and hold the Flashlight button for 4 seconds 
again to turn the flashlight off.

Note that the backlight and the flashlight use the same 
button on the Magellan Triton.  Press the button momentarily 
to control the backlight setting, press and hold the button to 
turn the flashlight on and off.

Menus

Accessing the features of the Magellan Triton is done through the Main Menu. The Main Menu has 
three options; Go To, Create and View.  Selecting one of these menu options brings up the menu for 
the corresponding function.  

Accessing the Main Menu

1. From the Map Screen, press MENU.

The Go To Menu has six options; Waypoint, Place, Trail, Geocache, Route, and Trips.

The Waypoint option provides a way to create a Go To route to a waypoint that has been saved 
to the Magellan Triton. 

The Place option is used to select a destination waypoint that has been either preloaded into 
the Magellan Triton as part of the internal base map or a destination waypoint found on a 
detailed map that have been loaded on an optional SD card.

The Trail option displays trails that you have saved previously. You can select the trail that you 
would like to follow from the list.

The Geocache option allows you to select a saved geocache waypoint and use it as the 
destination waypoint for a Go To route.

The Route option displays routes that you have created previously that you can select from to 
activate. 

The Trips option will be available in a future update.  Check the Magellan website at 
www.magellangps.com for information on updates to your Magellan Triton.

The Create Menu has the same options as the Go To Menu but these are used to create waypoints 
and multileg routes that can be saved by the Magellan Triton.

Use the Waypoint option to create a waypoint from your present location, by selecting a point 
on the map or by entering the coordinates for a known waypoint.

The Trail option provides a way for you to save your current track (a record of your travels since 
the last time track was cleared) as a route that you can use again to follow your current 
journey.

Press and hold 
for 4 seconds.
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The Geocache option allows you to add new geocache locations from your present position, by 
selecting a point on the map or by entering the coordinates of a known geocache.

The Route option is used to create a route with multiple legs.  These routes generally begin at 
your current location and go to a series of waypoints that could have been created and saved 
in the Magellan Triton from earlier trips or waypoints that are available from the base map or 
an optional detailed map. 

The Trips option will be available in a future update.  Check the Magellan website at 
www.magellangps.com for information on updates to your Magellan Triton.

The View Menu has options for many of the support functions and tools found in the Magellan Triton.

The Local Info option provides access to information about the best hunting and fishing times 
as well as solar and lunar rise and set times for the location of your cursor.

The Profiles option is used to customize the settings of the Magellan Triton for a particular 
activity; hiking, marine use or geocaching.

The Maps option displays a list of the base maps and available detail maps, that can be used.

The Media option contains the functions for taking and viewing photographs and movie clips.  
Other functions of the Media option are creating audio clips and playing MP3 music files.

Use Settings to access navigation settings, adjust volume and brightness, select connectivity, 
view memory details, as well as perform diagnostics.

Navigation Screens

The Triton has six navigation screens and a Satellite Status screen that can be accessed by pressing 
the PAGE / GO TO or ESC button  The Navigation Screens will be discussed in detail in the Navigation 
Screen chapter of this manual.

Navigation Screen options menus

The Map, Compass and Speedometer navigation screens have options menus that are associated with 
them providing access to additional functions.  

Accessing the Map Screen Options Menu

1. While viewing the Map screen, press ENTER.

2. Press ESC to close the options menu.

Accessing the Compass and Speedometer Options Menu

1. While viewing the Compass or Speedometer screen, press MENU.

For the Compass Screen you can select User Calibration or Set true north direction.

For Speedometer you can: Reset Odometer, Reset Trip Odometer, Reset Speed.

2. Press ESC to close the options menu.
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Data Fields

The Map screen, the Large Data screen, the Compass, and the Satellite 
Status screen have data field that can be customized to display 
navigation information.  You can change what information is being 
displayed from 20 different data type options.

Accessing the Data Fields on the Map Screen

1. While viewing the Map screen, tap on the arrow (circled in 
red) in the lower right corner.

2. Two data fields will appear.  Tap on it again and two more 
data fields appear.  A total of four can be displayed.

Customizing the Data Field

1. While viewing a screen that has customizable data fields, press ENTER.  The first data field 
will be displayed in pale orange.

2. Select the field you want to change and with it highlighted, press ENTER.

3. Select the data type desired from the list shown and press ENTER.

4. The Triton will return to the original screen with the data field customized to display the 
information selected.

Selecting Maps
Detailed maps, including National Geographic maps, can be purchased and downloaded from the 
Magellan Store and loaded automatically into your Magellan Triton from an SD card.  You will need 
to select the detailed map you want to use to activate it.

1. From the Map screen, press MENU. 

2. Select View.

3. Select Maps.

4. Select the detailed map from the list that you want to activate and press ENTER.

5. The font for the detailed map will turn blue when it is active.

6. Select the green checkmark.
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Battery Life

The following are things you can do to conserve the battery life in your Magellan Triton.

Turn off backlight during daytime use. 

1. Press the Backlight button (top left side of the receiver) to cycle through the backlight 
intensities.

(Alternate method)

1. Press MENU.

2. Select View.

3. Select Profiles.

4. Select a profile.

5. Press PAGE / GO TO to select the Display page.

6. Select Backlight Level.

Select a low backlight level during nighttime use.

1. Press the Backlight button (top left side of the receiver) to cycle through the backlight 
intensities.

(Alternate method)

1. Press MENU.

2. Select View.

3. Select Profiles.

4. Select a profile.

5. Press PAGE / GO TO to select the Display page.

6. Select Backlight Level.

Select a short backlight timer setting during nighttime use.

1. Press MENU.

2. Select View.

3. Select Profiles.

4. Select a profile.

5. Press PAGE / GO TO to select the Display page.

6. Select Backlight Level.

Disable the electronic compass if GPS fix is available.
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1. Press MENU.

2. Select View.

3. Select Profiles.

4. Select a profile.

5. Press PAGE / GO TO to select the Navigation page.

6. Select Electronic Compass and set it to OFF.

Disable the barometer if barometric pressure data is not required.

1. Press MENU.

2. Select View.

3. Select Profiles.

4. Select a profile.

5. Press PAGE / GO TO to select the Navigation page.

6. Select Barometer and set it to OFF.
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Connect to PC using USB cable (if possible).

1. Connect the Magellan Triton to a computer using the USB cable supplied with the Magellan 
Triton.

2. Select POWER ONLY from the options menu that is displayed.

Connect to Vehicle Power Adapter (optional accessory).

1. Connect the Magellan Triton to the optional vehicle power adapter.

2. Select POWER ONLY from the options menu that is displayed.

For optimal performance, use only brand name AA alkaline or lithium batteries.

Rechargeable AA batteries are not recommended.
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Navigation Screens

The Magellan Triton has six navigation screens and a Satellite Status screen.  The Navigation screens 
provide you with information to assist you in your journeys.  

Selecting Navigation Screens

1. While viewing one of the Navigation screens, press PAGE / GO TO (next screen) or ESC 
(previous screen) to select the navigation screen you are looking for.

Map Screen

The Map screen displays your present position at the arrow cursor along with map detail information 
provided from the base map.  (If you have an optional Detail Map loaded and are in an area covered 
by the detailed map, the map information from the detailed map will be displayed.)  

Waypoints (user-created or preloaded in the map) will be displayed by their icons on the screen.

A visual indication of your movements (track) is displayed on the 
map as an orange line with white dots. If the track has been saved, 
it appears as a blue dashed line (color is user customizable).  Also, 
if you have a route activated, it is shown on the map as solid yellow 
lines. (The trail colors can be modified.)  A pink line is also 
displayed that indicates the Position Destination Line.  The 
Position Destination Line is a straight line displaying LOS (line of 
sight) from your current location to the next destination waypoint.  
At the top right of the map is a north indicator that rotates to 
indicate north from your present heading and the map scale 
(circled) is displayed in the bottom left corner.  The header bar 
shows battery level, time of day and satellite signal strength.

Changing the Map Scale

1. While viewing the Map screen, press + ZOOM or ZOOM - to step through the different map 
scale levels.

Data Fields.  The Map screen can display up to four customizable data fields.  

Displaying the Map Screen Data Fields

1. Tap on the tab in the lower right corner of the screen and the 
first two data fields are displayed.

2. Tap again on the tab and two more data fields will be 
displayed.

3. Tap once more to hide all the data fields.
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Customizing the Data Fields

1. With the data fields displayed, tap on the field you want to change.

2. Select the data that you want to be displayed.  (You can do this by either tapping on the field 
or use the cursor control to highlight the field in orange and press ENTER.)

3. The Map screen will be displayed with the data field changed to the type selected.

4. The Map screen has two menus associated with it; the Main Menu and an Options Menu.  
The Main Menu is used to access the features of the Triton and the Options Menu can be 
used to create a waypoint at the cursor position, set a backtrack route or provide local 
information for the cursor position  (Other functions are also available if you have a route 
active or if you are in panning mode.)

Accessing the Main Menu

1. Press MENU while viewing the Map screen.  The Main Menu will appear.  Press ESC to close 
the menu and return to the Map screen.

Accessing the Options Menu

1. Press ENTER while viewing the Map screen.  The Options Menu appears.  Select the 
function desired or press ESC to return to the Map screen.

Map Cursors

There are two cursors that can be displayed on the Map screen.

The arrow cursor displays your present position (or last known position) on the map with the 
arrow pointing in the direction you are heading.  

The pan cursor (target icon) can be moved to any position on the map by using the cursor 
control or by tapping on the screen.  A small red dot around the cursor indicates the direction 
to your present position.  The pan cursor is used for adding waypoints to the map or creating a 
go to route from your present position to a spot on the map.  If you view local information 
while in pan mode, the information displayed will be for the position of the cursor. 

Cancelling Pan

1. When you are done panning around the map, press ESC to return the cursor to your present 
position.
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Viewing Best Fish and Hunt Times
If you are in Pan mode, this information will display for the location of 
the cursor position otherwise the information is for your current 
location.

1. While viewing the Map screen press ENTER.

2. Select Local Info. 

3. Select Fish and Hunt.

4. Select the arrows at the top of the display to scroll through the 
dates.  Tap the date displayed at the top of the display to use 
the calendar to select a date.

5. Press the green checkmark when done.

Viewing Sun and Moon Rise and Set Times
If you are in Pan mode, this information will display for the location of 
the cursor position.  While in normal mode, this information is for your 
present position

1. While viewing the Map screen press ENTER.

2. Select Local Info.

3. Select Sun and Moon.

4. Select the arrows at the top of the display to scroll through the 
dates.  Tap the date displayed at the top of the display to use 
the calendar to select a date.

5. Press the green checkmark when done.

Current Location Screen

The Current Location screen contains information about your present 
position as well as the distance and bearing to your next waypoint 
destination if there is an active route being used.

To reset the odometer, go to the Speedometer screen and follow the 
instructions provided for resetting the odometer.
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